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Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
MCP19061 Four Switch Buck-Boost Evaluation Board. Items discussed in this chapter 
include:

• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Website

• Development Systems Customer Change Notification Service

• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This chapter describes how to use the MCP19061 Four Switch Buck-Boost Evaluation 
Board as a development tool to emulate and debug firmware on a target board. The 
manual layout is as follows:

• Chapter 1. “Product Overview” – Includes a short overview of the MCP19061 
device, and a general description of the MCP19061 Four Switch Buck-Boost 
Evaluation Board.

• Chapter 2. “Installation and Operation” – Includes instructions on how to get 
started with the Four Switch Buck-Boost Evaluation Board, a detailed description 
of the board, and the typical waveforms that are obtained from the board.

• Appendix A. “Schematics and Layouts” – Shows the schematic and layout 
diagrams for the Four Switch Buck-Boost Evaluation Board.

• Appendix B. “Bill of Materials (BOM)” – Lists the parts used to build the Four 
Switch Buck-Boost Evaluation Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics, to open a list of available online help files.
 2024 Microchip Technology Inc.and its subsidiaries  DS50003664A-page 5



MCP19061 Four Switch Buck-Boost Evaluation Board User’s Guide
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING
This user’s guide describes how to use the MCP19061 Four Switch Buck-Boost 
Evaluation Board. Another useful document is listed below. The following Microchip 
document is available and recommended as a supplemental reference resource:

• MCP19061 Data Sheet – “USB-PD Four Switch Buck-Boost Analog Front 
End” (DS20006888) – This data sheet provides detailed information regarding 
the MCP19061 devices.

THE MICROCHIP WEBSITE
Microchip provides online support via our website at www.microchip.com. This website 
is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the website contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE 
Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive email notifications whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip website at www.microchip.com, click on Product 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers - The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK 
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators - The latest information on Microchip in-circuit emulators.This includes 
the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers - The latest information on the Microchip in-circuit debug-
gers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 Debug 
Express.

• MPLAB IDE - The latest information on Microchip MPLAB IDE, the Windows Inte-
grated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers - The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART Plus and PICkit 
2 and 3 programmers.
 2024 Microchip Technology Inc.and its subsidiaries  DS50003664A-page 7
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the website at: 
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (March 2024)

• Initial release of this document.
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Chapter 1.  Product Overview
1.1 INTRODUCTION

This chapter provides an overview of the MCP19061 Four Switch Buck-Boost 
Evaluation Board and covers the following topics:

• MCP19061 Device – Short Overview

• What is the MCP19061 Four Switch Buck-Boost Evaluation Board?

• What Does the MCP19061 Four Switch Buck-Boost Evaluation Board Kit Include?

1.2 MCP19061 DEVICE – SHORT OVERVIEW

The MCP19061 is a highly-integrated, mixed-signal, four switch buck-boost controller 
which includes a digital PWM controller with a serial communication bus for external 
programmability and reporting.The MCP19061 can be used for USB power delivery 
and can provide USB-PD compatibility with a minimum of external components. It can 
be used in applications such as USB-PD, four switch buck-boost converter, battery 
chargers, general purpose constant voltage constant current power supply, and LED 
driver. 

Since the MCP19061 uses digital control circuitry to regulate the output of the DC/DC 
converter, the integration of a high-speed I2C serial bus is used for device 
communications from the MCP19061 to the system controller. These communications 
can provide a full configurability of an (AFE) controller for device operating parameters 
such as: output range (constant current operation, constant voltage operation), 
switching frequency range of 300 kHz to 500 kHz, protections (input and output 
overcurrent, input over/undervoltage, output over/under voltage, load dump, 
overtemperature, internal regulator fault, output discharge fail, bootstrap undervoltage 
detection, vsafe0 detection).

The MCP19061 is designed to efficiently operate from 4.5V to 36V and can stand 42V 
nonoperating.

The MCP19061 can deliver an adjustable output range of 3V to 36V. It features 
integrated synchronous 4-switch buck/boost architecture, three internal linear regulator 
and MOSFET drivers, all in a space-saving 32-pin, 5 x 5 mm, QFN package.

The board can be configured according to the user's application using the MCP2221A 
USB to I2C Bridge present on the board. The configuration can be done through the 
Graphic User Interface (GUI). 

The Digital Interface is externally supplied using the VDDIO selection header (J6).
 2024 Microchip Technology Inc.and its subsidiaries  DS50003664A-page 9
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FIGURE 1-1: MCP19061 Four Switch Buck-Boost Block Diagram.

1.3 WHAT IS THE MCP19061 FOUR SWITCH BUCK-BOOST EVALUATION 
BOARD?

The MCP19061 Four Switch Buck-Boost Evaluation Board demonstrates how the 
MCP19061 device operates in Buck, Boost and Buck-Boost topologies over a wide 
input voltage and load range. Nearly all operational and control system parameters are 
programmable by utilizing the I2C MCP2221 module.

For precise measurements of output current, a 5 mΩ shunt is used. 

The Graphical User Interface (GUI) can be used to modify the functioning parameters, 
and check operational status. To simplify the connection, a USB-to-I2C communication 
bridge is implemented on board, using the MCP2221-I/ML, 16-Lead, 4x4 QFN, allowing 
standard interface to any Microsoft® Windows® computer. 

The MCP19061 Four Switch Buck-Boost Evaluation Board is also intended to 
demonstrate an optimized Printed Circuit Board (PCB) layout that minimizes parasitic 
noise while increasing efficiency and power density. Proper PCB layout is critical to 
achieve optimum MCP19061 operation, as well as power train efficiency and noise 
minimization.

1.4 WHAT DOES THE MCP19061 FOUR SWITCH BUCK-BOOST EVALUATION 
BOARD KIT INCLUDE?

This MCP19061 Four Switch Buck-Boost Evaluation Board kit includes:

• The MCP19061 Four Switch Buck-Boost Evaluation Board (EV82S16A)

• USB-A to USB-C Cable

• Important Information Sheet
DS50003664A-page 10   2024 Microchip Technology Inc. and its subsidiaries
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Chapter 2.  Installation and Operation
2.1 INTRODUCTION

This chapter provides a detailed description of the MCP19061 Four Switch Buck-Boost 
Evaluation Board, instructions on how to use the board, and lists the typical waveforms 
obtained from it.

The chapter is laid out as follows:

• MCP19061 Four Switch Buck-Boost Evaluation Board Features

• Getting Started

• Setup Procedure

• Operating the MCP19061 Four Switch Buck-Boost Evaluation Board

• Typical Performance Data and Waveforms

2.2 MCP19061 FOUR SWITCH BUCK-BOOST EVALUATION BOARD FEATURES

The MCP19061 Four Switch Buck-Boost Evaluation Board was developed to provide 
a compact, low-cost and highly-efficient DC/DC conversion for medium-to-high
output currents.

The key features of the MCP19061 Four Switch Buck-Boost Evaluation Board include:

• Input Voltage Range: 4.5V to 36V

• Adjustable Output Voltage Range: 3V to 36V

• Maximum Output Current: 10A (can be adjusted from 0A to 10A)

• Maximum Power: 100W

• Switching Frequency Range: 300 kHz to 500 kHz (can be adjusted)

• On-Board High Performance Power MOSFET Transistors

• Input and Output Overcurrent Protections 

• Input and Output Undervoltage and Overvoltage Protections

• Load dump, Overtemperature and Internal Regulator Fault Protections

• Status Report (including errors, input voltage, output voltage and current) via I2C 
Communication

• Internal Events Detection Pin (nALERT)

• Input Undervoltage (IVMUVF) and Overvoltage (IVMOVR) Lockout with 
Programmable Thresholds (via the GUI)

• Output Undervoltage (OVMUVF) andOvervoltage (OVMOVR) with Programmable 
Thresholds (via the GUI)

• Output Overcurrent (OCROCR) with Programmable Rising Threshold (via the 
GUI).
 2024 Microchip Technology Inc. and its subsidiaries  DS50003664A-page 11
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2.3 GETTING STARTED

The MCP19061 Four Switch Buck-Boost Evaluation Board is fully assembled and 
tested to evaluate and demonstrate the MCP19061 device capabilities.

2.3.1 Necessary Instruments and Tools Required for Operation

• Adjustable DC power supply with 0V–36V/15 ADC range output capability

• Electronic load with at least 5A current capability and load stepping capability

• Digital oscilloscope with a minimum bandwidth of 50 MHz

• Digital voltmeter/ammeter

• Wires for connections; these wires must sustain high currents:

- 15A for the connection between the adjustable DC power supply and board

- 10A for the connection between the board and the electronic load

2.4 SETUP PROCEDURE

FIGURE 2-1: MCP19061 Four Switch Buck-Boost Evaluation Board – Top View.

To set up the MCP19061 Four Switch Buck-Boost Evaluation Board, complete the 
following steps:

1. Connect the electronic load to J2 with the correct polarity (positive side (+) and 
negative side (-) as shown in Figure 2-1).

2. Connect the adjustable DC power supply to J3 with the correct polarity (positive 
side (+) and negative side (-) as shown in Figure 2-1).

3. Set the DC voltage supplied by the adjustable DC power supply to 12V and turn 
it on.

4. Place the VDDIO selection header jumper in the LDO position and the shutdown 
selection header jumper in the HI position.

5. The board is preconfigured to supply 5V on the Output, with the current set to its 
DS50003664A-page 12   2024 Microchip Technology Inc. and its subsidiaries
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maximum value, when the enable selection header jumper is placed in the HI 
position (power train Enable).

6. For additional control, connect the MCP19061 Evaluation Board to the computer 
(on which the MCP19061 Monitoring GUI is installed) via the USB-A to USB type 
C cable supplied, by using the J5 connector on the board. When using the GUI, 
the enable selection header jumper should be placed in the LO position (I2C 
Control).

7. Open the MCP19061 Dev Board GUI and the board should be automatically 
recognized by the GUI and the Basic PSU tab becomes active. If the board is not 
recognized press the “Scan” button, select Address 0x51 and click “Connect”.

8. To enable the output, set a voltage value in the “Vout [V] WRITE” box, and press 
the “OUTPUT ON/OFF” button. The button will turn green and the output should 
rise to the programmed voltage.

2.4.1 Graphic User Interface (GUI)

FIGURE 2-2: MCP19061 GUI.

The GUI provides the necessary parameter settings and allows the user to save the 
configuration for the selected operation mode.

The GUI is organized in the following tabs:

• Basic PSU - Operates as a simple power supply controller and offers the user the 
option to set the output voltage, output current (for constant current operation), 
output and input voltage protection levels, output current protections and can 
signal alerts for overvoltage, overcurrent, overtemperature etc., by reading the 
Error Flags.

• Basic USB - Operates as a USB power supply where the user can select USB 
 2024 Microchip Technology Inc. and its subsidiaries  DS50003664A-page 13
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power profiles. The protection levels are automatically updated with respect to the 
selected USB power profile.

• Advanced - Operates as a power supply as described in Basic PSU, but with 
access to more advanced features such as setting control loop parameters ramp, 
gain, switching frequency, etc., by directly accessing the memory.

• Hardware Configuration (HW Config) - Sets the system parameters with 
respect to the system hardware configuration. The options are: output capacitor 
and inductor values, shunt resistor values, switching frequency, dead time, 
dithering.

2.4.1.1 ERROR FLAGS

• VDDIOUV - VDD_IO undervoltage was detected

• ADCREFUV - ADC reference undervoltage was detected

• VDD50UV - VDD, 5V rail undervoltage was detected

• AVDD40UV - Analog 4V supply undervoltage was detected

• LOSECLKSYS - System clock loss was detected

• LOSECLKPLL - PLL clock loss was detected

• LOSESYNC - Synchronization loss was detected

• DISCHFAIL - Output discharge fail was detected

• UOLD - USB overload was detected

• SUFAIL - Startup failure was detected

• ICMOC - Input overcurrent was detected

• OCROC - Output overcurrent was detected

• OCRREVC - Output reverse current was detected

• OCRSC - Output short circuit was detected

• VBSTUV - Bootstrap supply undervoltage was detected

• OVTGDR - Gate drivers overtemperature was detected

TABLE 2-1: MCP19061 FOUR SWITCH BUCK-BOOST EVALUATION BOARD GUI DESCRIPTION

Item Description

OUTPUT ON
When pressed, enables/disables the power train. The button turns RED when the 
power train is OFF and GREEN when power train is ON. (Note 1)

Read All
Retrieves the values read by the ADC for the input voltage, output voltage, input 
current.

Continuous Read
When checked, enables ADC continuous readings for: input voltage, output voltage, 
output current.

Write All When pressed, writes the setpoints for the output voltage and output current.

Read Protection Values
When pressed, reads the current values for the input/output undervoltage, 
overvoltage, and output overcurrent protections.

Write Protection Values
When pressed, writes to the NVM the current values for the input/output 
undervoltage, overvoltage, and output overcurrent protections.

Factory Reset
When pressed, restores the initial default factory values for all the parameters shown 
in the current window.

Load From NVM
When pressed, all the parameters in the present window are loaded from the 
nonvolatile memory (NVM).

Save To NVM
When pressed, all the parameters in the present window are saved to the nonvolatile 
memory and will be automatically loaded to registers on the next power cycle.

Clear Errors
When pressed, clears all error flags.
If an error is still present, the “ALERT” indicator will turn red.

Note 1: The OUTPUT ON button is available only when jumper J8 placed in the LO (I2C Control) 
positon.
DS50003664A-page 14   2024 Microchip Technology Inc. and its subsidiaries



Installation and Operation
• OVTVDD50 - 5V VDD regulator overtemperature was detected

• OVTAVDD40 - 4V Analog VDD regulator overtemperature was detected

• IVMOV - Input overvoltage was detected

• IVMUV - Input undervoltage was detected

• IVMLD - Input load dump was detected

• OVMOV - Output overvoltage was detected

• OVMZV - Output vsafe0 was detected

• CRCERR - NVM CRC error was detected

2.4.1.2 SAVING THE CONFIGURATION

The GUI offers the possibility to download the current register configuration to .csv file 
by selecting the “File” menu and “Save registers to file”.

To load a saved register configuration, select “Load registers from file” in the “File” 
menu.

To generate a C header file with the current register configuration, select “Export 
register map to C file” from the “File” menu, or you can use the “Export register map 
to C file” button in the “Advanced” tab.

2.4.1.3 BASIC USB

FIGURE 2-3: Basic USB Tab.

The Basic USB tab is used as a shortcut to set the output voltage, current and 
protection values for the following predefined USB profiles:
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Output ON/OFF, Read Values, Write Values, Factory Reset, perform the exact 
functions as described in the Basic PSU tab.

When a USB power profile is selected, the recommended values for the output 
protection will be loaded automatically in the current window but will not be written in 
the registers until “Write Protection Values” button is pressed.

2.4.1.4 ADVANCED

FIGURE 2-4: Advanced Tab.

• The Advanced tab offers direct access to the Register Map.

• The upper row shows the detailed bitwise description of the selected register and 
the corresponding fields.

• The value of the register can be modified by clicking and writing the desired value 

TABLE 2-2: PREDEFINED USB PROFILES

Protocol Profiles Output Voltage Current Protection Values

PD 1.0 1 5V 2A 10W

PD 1.0 2 12V 1.5A 18W

PD 1.0 3 12V 3A 36W

PD 1.0 4 20V 3A 60W

PD 1.0 5 20V 5A 100W

PD 2.0/3.0 1 5V 3A 15W

PD 2.0/3.0 2 9V 3A 27W

PD 2.0/3.0 3 15V 3A 45W

PD 2.0/3.0 4 20V 5A 100W
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in the value field of the corresponding register. The value can also be modified 
bitwise by clicking the corresponding bit, which will toggle it.

For a detailed description of each register, please see the MCP19061 Data Sheet.

2.4.1.5 HARDWARE CONFIGURATION

FIGURE 2-5: Hardware Configuration Tab.

The Hardware Configuration (HW Config) tab allows the user to input the parameters 
of the hardware setup for proper operation:
• Out SHUNT value is used for current regulation (IOUT) and output current 

reporting.
• In SHUNT is used for the input overcurrent protection.
• The Output capacitor and inductor values impact the system stability and transient 

response.
• The Dither checkbox enables the frequency dither, to spread the noise spectrum.
• Dead Time box offers the option to set the deadtime between high side and the 

low side switch. The available range is 0 to 186 ns in steps of 6 ns. 

TABLE 2-3: ADVANCED TAB BUTTON DESCRIPTION

Item Description

Read Selected Returns the value of the current selected register.

Read All Returns the values for the whole Register Map.

Write Selected Writes the value for the current selected register.

Write All
Writes the entire Register Map using the values in the selection 
window.
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2.5 OPERATING THE MCP19061 FOUR SWITCH BUCK-BOOST EVALUATION 
BOARD

Figure 2-6 shows the board typical test setup.

FIGURE 2-6: MCP19061 Four Switch Buck-Boost Evaluation Board - Typical 
Test Setup.

Table 2-4 lists all the available test points on the board.

The user can connect various instruments to the listed test points to evaluate the 
parameters of the converter. The typical performance data, curves and waveforms are 
presented in Section 2.6 .

TABLE 2-4: TEST POINTS DESCRIPTION

Label Function Description

TP6, TP7, TP8, 
TP9, TP10, 
TP11, TP18

GND Power GND

TP12 VIN Input Voltage 

TP13 VOUT Output Voltage 

TP1 VDD_IO Digital Interface Supply

TP2 VDD Internal Regulator Output

TP3 AVDD Analog Voltage Regulator Output

TP4 DVDD Digital Supply

TP5 ADR Analog to Digital Converters Reference

TP17 HG1 Buck Leg High Gate

TP23 LG1 Buck Leg Low Gate

TP14 HG2 Boost Leg High Gate

TP24 LG2 Boost Leg Low Gate

TP15 HS1 Buck Leg Switching Node 

TP16 HS2 Boost Leg Switching Node

TP21 ISPIN Input Current Sense Amplifier (+)

TP22 ISNIN Input Current Sense Amplifier (-)

TP19 ISPOUT Output Current Sense Amplifier (+)
DS50003664A-page 18   2024 Microchip Technology Inc. and its subsidiaries
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2.6 TYPICAL PERFORMANCE DATA AND WAVEFORMS

Table 2-6 describes the converter parameters.

Figure 2-7 through Figure 2-13 show the typical waveforms that are obtained from the 
evaluation board.

FIGURE 2-7: Output Voltage Ripple/Noise (VIN = 12V, VOUT = 5V, IOUT = 1A, 
BW = 20 MHz).

TP20 ISNOUT Output Current Sense Amplifier (-)

TP25 nALERT Internal Events Detect

TP26 SYNC Configurable Input or Output Synchronization

TABLE 2-5: CONNECTORS DESCRIPTION

Label Description

J1 Synchronization selection 

J2 Output Voltage

J3 Input Voltage 

J4 PICkit™ Serial/MCP2221

J5 USB-C

J6 VDDIO Selection 

J7 SHUTDOWN selection 

J8 ENABLE Selection

TABLE 2-4: TEST POINTS DESCRIPTION (CONTINUED)

Label Function Description

TABLE 2-6: MCP19061 EVALUATION BOARD PARAMETERS

Parameter Value Comments

Input Voltage Range (V) 4.5-36 —

Output Voltage Range (V) 3-36 ± 2.5% tolerance

Maximum Output Current (A) 10 Steady state output current

Output Voltage Ripple (mV) < 50 VIN = 12V, IOUT = 1 A

Switching Frequency Range (kHz) 300-500 —
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FIGURE 2-8: Output Voltage Ripple/Noise (VIN = 12V, VOUT = 5V, IOUT = 3A, 
BW = 20 MHz).

FIGURE 2-9: Output Voltage Ripple/Noise (VIN = 12V, VOUT = 12V, IOUT = 1A, 
BW = 20 MHz).
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FIGURE 2-10: Output Voltage Ripple/Noise (VIN = 12V, VOUT = 12V, IOUT = 3A, 
BW = 20 MHz).

FIGURE 2-11: Output Voltage Ripple/Noise (VIN = 12V, VOUT = 20V, IOUT = 1A, 
BW = 20 MHz).
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FIGURE 2-12: Output Voltage Ripple/Noise (VIN = 12V, VOUT = 20V, IOUT = 3A, 
BW = 20 MHz).

FIGURE 2-13: MCP19061 Evaluation Board Efficiency (VIN = 12V, IOUT = 3A).
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Appendix A. Schematics and Layouts
A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP19061 Four 
Switch Buck-Boost Evaluation Board (EV82S16A):

• Board – Schematic

• Board – Top Silk

• Board – Top Copper and Silk

• Board – Top Copper

• Board – Bottom Copper

• Board – Bottom Copper and Silk

• Board – Bottom Silk
 2024 Microchip Technology Inc. and its subsidiaries  DS50003664A-page 23
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Schematics and Layouts
A.3 BOARD – TOP SILK

A.4 BOARD – TOP COPPER AND SILK
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A.5 BOARD – TOP COPPER

A.6 BOARD – BOTTOM COPPER
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Schematics and Layouts
A.7 BOARD – BOTTOM COPPER AND SILK

A.8 BOARD – BOTTOM SILK
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Appendix B. Bill of Materials (BOM)
TABLE B-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

1 C1 Capacitor, ceramic, 1 μF, 100V, 
10%, X7R, SMD, 1210

KEMET C1210C105K1RACTU

1 C2 Capacitor, ceramic, 1000 pF, 50V, 
20%, X7R, SMD, 0603

TDK Corporation C1608X7R2A102K080AA

1 C3 Capacitor, ceramic, 1 μF, 10V, 
20%, X7R, SMD, 0603

Samsung 
Electro-Mechanics 
America, Inc.

CL10B105KP8NNNC

2 C4, C5 Capacitor, ceramic, 0.47 μF, 16V, 
10%, X7R, SMD, 0603

Murata Electronics® GRM188R71C474KA88D

5 C6, C7, C8, C9, 
C28

Capacitor, ceramic, 4.7 μF, 10V, 
10%, X7R, SMD, 0805

TDK Corporation C2012X7R1A475K125AC

12 C10, C11, C12, 
C13, C14, C15, 
C17, C18, C19, 
C20, C21, C22

Capacitor, ceramic, 10 μF, 50V, 
20%, X7R, SMD, 1210

Kyocera AVX® CM32X7R106M50AT

3 C16, C23, C24 Capacitor, aluminum, 220 μF, 50V, 
20%, RAD, P5D10H15.7

Panasonic® - ECG EEH-AZS1H221B

2 C25, C26 Capacitor, ceramic, 1 μF, 50V, 
10%, X7R, SMD, 0805

Samsung 
Electro-Mechanics 
America, Inc.

CL21B105KBFNNNE

2 C27, C30 Capacitor, ceramic, 0.1 μF, 50V, 
20%, X7R, SMD, 0603

TDK Corporation C1608X7R1H104M080AA

1 C29 Capacitor, ceramic, 1 μF, 10V, 
10%, X5R, SMD, 0603

Murata Electronics GRM188R61A105KA61D

2 D1, D2 LED, yellow, green, 0603, SMD Vishay® Intertechnology, 
Inc.

VLMG1300-GS08

1 J1 Connector, header-2.54, male, 
1x2, gold, 5.84 MH, TH, vertical

Würth Elektronik 61300211121

2 J2, J3 Connector, terminal, 5.08 mm, 
1X2, female, 16-30AWG, 13.5A, 
TH, RA

TE Connectivity, Ltd. 282836-2

1 J4 Connector, header-2.54, male, 
1x6, Tin, 5.84 MH, TH, vertical

Sullins Connector 
Solutions

PEC06SAAN

1 J5 Connector, USB 2.0, Type-C, 
female, SMD/TH, R/A

GCT Semiconductor Inc. USB4105-GF-A

3 J6, J7, J8 Connector, header-2.54, male, 
1x3, Tin, 5.84 MH, TH, vertical

Samtec, Inc. TSW-103-07-T-S

3 JP6, JP7, JP8 Mechanical, headers and wires, 
jumper, 2.54 mm, 1x2

Amphenol ICC (FCI) 63429-202LF

Note: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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1 L1 Inductor, 4.7 μH, 29A, 20%, 
0.0038R, SMD, L16.2W15.2H10, 
AEC-Q200

Coilcraft XAL1510-472MED

1 LABEL1 Label, assembly with rev level  
(small modules) per MTS-0002

Raynen 10010276

4 PAD1, PAD2, 
PAD3, PAD4

Mechanical, headers and wires, 
rubber pad, hemisphere, D6.4, 
H1.9, clear

3M SJ5382

4 Q1, Q2, Q3, Q4 Transistor, MOSFET, N-Channel, 
60V, 57A, 0.0069R, TDSON-8

Infineon Technologies 
AG

ISC0703NLSATMA1

1 R1 Resistor, thick film, 100R, 5%, 
1/10W, SMD, 0603

Vishay Intertechnology, 
Inc.

CRCW0603100RJNEA

9 R2, R13, R14, 
R16, R17, R19, 
R20, R21, R22

Resistor, thick film, 4.7k, 5%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3GEYJ472V

2 R3, R4 Resistor, metal film, 0.005R, 1%, 
WW, SMD, 2512

Bourns® Inc. CRE2512-FZ-R005E-3

4 R5, R6, R11, R12 Resistor, thick film, 3.9R, 1%, 
1/3W, SMD, 0603, AEC-Q200

ROHM Semiconductor SDR03EZPF3R90

4 R7, R8, R9, R10 Resistor, thick film, 0R, 1/10W, 
SMD, 0603, AEC-Q200

Panasonic - ECG ERJ-3GEY0R00V

2 R15, R23 Resistor, thick film, 1k, 5%, 1/10W, 
SMD, 0603

Panasonic - ECG ERJ-3GEYJ102V

1 R18 Resistor, thick film, 330R, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF3300V

2 R24, R25 Resistor, thick film, 5.1k, 1%, 
1/10W, SMD, 0603

Panasonic - ECG ERJ-3EKF5101V

21 TP1, TP3, TP4, 
TP5, TP6, TP7, 
TP8, TP9, TP10, 
TP11, TP12, TP13, 
TP14, TP15, TP16, 
TP17, TP18, TP23, 
TP24, TP25, TP26

Miscellaneous, test point, multi 
purpose, mini, white

Keystone® Electronics 
Corp.

5002

5 TP2, TP19, TP20, 
TP21, TP22

Miscellaneous, test point, PC, Mini, 
0.040", D, yellow

Keystone Electronics 
Corp.

5004

1 U1 Analog, PWM controller, 
300-500 kHz, VQFN-32

Microchip Technology 
Inc.

MCP19061-E/RTB

1 U2 Analog, voltage, regulator, 5.0V, 
3LD, SOT-23A-3

Microchip Technology 
Inc.

MCP1792T-5002H/CB

1 U3 Interface, USB, I2C/UART, QFN-16 Microchip Technology 
Inc.

MCP2221A-I/ML

1 PCB1 Printed Circuit Board — 04-12109-R1

TABLE B-1: BILL OF MATERIALS (BOM)

Qty. Reference Description Manufacturer Part Number

Note: The components listed in this Bill of Materials are representative of the PCB assembly. The released BOM 
used in manufacturing uses all RoHS-compliant components.
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